PxEdit 4.0

Main window
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Design principles

* The user interface should be easy to use and as
functional as possible

* The interface should reflect changes immediately

* New features are added when they are feasible,
sensible and necessary
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Main window

PxEdit 2019.4.0

File Edit Settings

Window Language

- B « The main window may be used as

Help
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a drag and drop target
file icons (.px, .pxk, .xIs, .csy, .txt, ...)

zip files also, but separately
directory icons

* There are many shortcuts

Ctrl+m metadata editor
Ctrl+]  table joining
Ctrl+o file opening
Ctrl+n create a new table
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System tray

* The quick launch menu is

Import keywords.. Ctrl+i

impon o it dtabse available even though the

mport from

main window I1s minimised

Graph.. Ctrl+g
Find and replace.. Ctrl+f
Find value.. Shift+ Ctrl+f
Undo Ctrl+z
Copy.. Ctrl+c
Paste Ctrl+v
Compare..

Data report..

Join tables.. Ctrlsj

Combine variables..

Split variable..
Database >
Convert to >
Clone Ctrl+d
Clone view Shift+ Ctri+d
File > ANSI <-> DOS
Edit > ANSI <-> Big5
Settings >
Window >
Language >
>

Hel
$ @ F3Q AN 1233 [
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File menu
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File menu /1

PxEdit 2019.4.0

New [Ctrl+n]

File Edit 5Settings Window Language
 create a new table from scratch

Mew.. Ctrl+n

Open.. Ctrl+o

Read * ¢ Open [Ctr|+0]

save Ctrl=s * open a px-file (.px)

Save as., Shift+Ctrl+s

Save all

o } * Read sub-menu

D:/PxEdit/doc/synt_005_201700.px Ctrl+1  for special cases

E:/Aikasarjat/Ammattikorkeakoulut/2003/AMKE203. px Ctrl+2

D:/patest/erikieliset/Albanian.px Ctrl+3 ° Save [Ctr| +S]

O/ pxtest/varoitukset/wrn_languagel.px Ctrl+4 .

e } « save the current table as a px file

e X with the same (existing) name

CSV files > .

Close all but active Shift+ Ctrl+g y Save aS [Sh Ift+Ctr| +S]

Close all Ctrl+q « save the current table as a px or pxk

et Alt=F4 file with (possibly) a new name
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File opening

“| « The Unicode files should always

~ v » Tamd tietokone » PX-Store (E) » World » Greenland v | O Hae: Greenland el
.
=-m @ have the appropriate header (BOM)
=
tmp ~ Mirni Muockkauspéivi Tyyppi Koko o . . . N
& OneDrive Arbejdsmarked 26.3.2015 10.30 Tiedostokansio I n th e beg I n n I n g Of th e fl le
B T 6 Befolkning 26.3.201510.30 Tiedostokansio
= Tami tietokane Boliger 26.3.2015 10,30 Tiedostokansio
B 3D-objektit Energi 26.3.201510.30 Tiedostokansio
=] Kuvat Erhwvervsstruktur 26.3.2015 10.30 Tiedostokansio ° If th . h d . 1 1 th f I
* Ladatut tiedosto Fiskeri og fangst 26.3.2015 10.30 Tiedostokansio IS e a e r IS I I I ISSI n g ] e I e
J, Musiikki Indkomster 26.3.201510.30 Tiedostokansio . . .
characters may look like gibberish
MNationalregnskab 26.3.2015 10,30 Tiedostokansio
I Tyopoyta - : :
) Offentlige finanser 26.3.201510.30 Tiedostokansio
B Videot Priser 26.3.2015 10.30 Tiedostokansio
== USB-muistitikku Sociale ydelser 26.3.201510.30 Tiedostokansio . .
2 Windows (C) Sttistic ibog 26320151030 Tiedostokansio e The file type menu has the Unicode

- Datalevy (D4) Tobak og alkehol 26.3.2015 10,30 Tiedostokansio

NISEEN, DO S - alternative, which will always try to
P files (Unicode) (*.px)

£

convert the file coding into Unicode

Sl  this may prevent reading of the
WInNANSI coded files, though
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File menu /2

@ peseaioss e Save all sub-menu
HE| RoR Settings Window language - save all tables in various file types

Mew.. Ctrl+n

P e - Save to sub-menu

e Cotoe - for different alternatives

Save as., Shift+Ctrl+s ]

Save a « Recently opened files [Ctrl+#]

Save to ¥

D:/PxEdit/doc/synt_005_201700.px Ctrl+1 ° . _

E:/Aikasarjat/Ammattikorkeakoulut/2003/AMKE203. px Ctrl+2 Flle type SUb menus

D/ pactest/erikieliset/Albanian.px Ctrl+3 « opened files are grouped by file type

O/ pxtest/varoitukset/wrn_languagel.px Ctrl+4

PXfiles >  Close all but active [Shift+Ctrl+q]

Text files >

CSV files } * Close all [Ctrl+(]

Close all but active Shift+ Ctrl+g

Cl.chseall Ctrl+q ° EXIt [A|t+F4]

Exit Alt+F4 . .

« close all tables and the application |
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New table

Create a new table

X e Title and variable names

Title: | — enter the new table title —

 value names are based on variable names

variable

Municipality

values
313

codes

column variable

 anew line will be added when needed

Year

60

Gender

3

* The number of values for each variable

O& OO

1

O& & O

* Numeric codes may be created if
needed (1, 2, 3, ..)

Remember settings

Create

5 340  Variables may be arranged in rows
Clear Close (default) or in columns

£

November 12th, 2019

 The Create button makes the table with
the Fill items

 Clicking any field in the values column
with the second mouse button enables
adding and removing classifications
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Fille|Read menu /1

e A I

:ﬁd Ctrl ) ZTct:lend Shift+ Ctrl ° TeXt file
:u:; 5hi1"t+CtrI+s/ File list Shift+ Alt+v ° read a S'[I’UC'[UI’&| text flle
e a—VME e | Do  Clipboard [Shift+Ctrl+V]
o  read a structural table from the clipboard
« active only if there is something available
* may be used with most of the applications
(e.g. LibreOffice)
* File list [Shift+Alt+Vv]
* read the files whose names are listed
In the clipboard
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Fille|Read menu /2

all
to

L e B Ve
[ I =TI - TR )
€ T ©
m m m m
w
e

D:/PxEdit/doc/synt_005_201700.px

E:/Aikaszarjat/ Ammattikorkeakoulut/2003/AMKE203. px

Pl Fmndb et Fmwileimlim e PR

November 12th, 2019

> Text file..
Ctrl+s Clipbeoard
Shift+Ctrl+s File list
Excel worksheet
% Excel workbook
Ctrl+1 Excel file..
Ctrl+2 Excel cheets..

Shift+ Ctrl+wv
Shift+Alt+v

Ctrl+e
Shift+Ctrl+e

Veli-Matti Jantunen, Statistics Finland

« Read worksheet or workbook from
opened Excel application [Ctrl+e,
Shift+Ctrl+e]

« read a structural table (or all sheets)
directly from the active spreadsheet

» the cell comments will be copied to the
corresponding keywords

» the footnotes should be separated with at
least two empty rows from the table

* needs Excel to be installed

 Read Excel file

 read a structural table from an Excel file
(xIs/xIsx)

* either the first worksheet or all sheets

n il
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File|]Save to menu /1

uuuuuuu T

Save to > Text e Ctrl+t ° TeXt flle [Ctr|+t]
D:/PxEdit/doc/synt_005_201700.px Ctrl+1 CVfile. ]
E:/Aikasarjat/Ammattikorkeakoulut/2003/AMKE203. px Ctrl+2 Prlob-C3V e save as a structural ASCII f||e, or
D/ pxtest/erikieliset/Albanian.px Ctrl+3 eXlist-C5V . .
D:/pxtest/varoitukset/wrn_languagel.px Ctrl+4 Clipboard ® make a. SpeCIaI formatted teXt flle
. - Excel
_T:::; : Excel sheet .
CSV files > Excel file.. ¢ CSV flle
Cls bt S S - save the table as a semicolon-
Gt gy | MKl separated file (csv)
Sparse matri. * most spreadsheets accept this
Partial tables..
Archive..
explorer file ¢ PX\]Ob_CSV
e « save the table as a semicolon-
separated metadata control file
» this can be used in PxJob for
metadata injection
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File|Save to menu /2

uuuuuuu T

Saveto > Text e Ctrl+t ° eX|St'CSV
D:/PxEdit/doc/synt_005_201700.px Ctrl+1 CVfile. ] ]
E:/Aikasarjat/Ammattikorkeakoulut/2003/AMKE203. px Ctrl+2 :ﬁ“b;‘? e (Create a Update file for the eXist
O/ putest/erikieliset/ Albanian.px Ctrl+3 1t T H : 1
D:..‘Extestfvaroitukse‘tfwrn_lan:uage'l.px Ctrl+4 Clipboard database used In StatIStICS Flnland
PX files > Exccel
. Excel sheet -
ot e i * Excel alternatives
Close all but active ShiftsCuleq | XMLADFfile. « Excel: move table to a new worksheet
Closea il R in a new workbook
Exit Alt+FA AML/Keys file..
:;ML: « Excel sheet: move table to a new
Partal tables. worksheet in the active workbook
Archive.. R .
- « Excelfile: save as an xls/xIsx file
PRl * notes will be moved to appropriate cell
comments
November 12th, 2019 Veli-Matti Jantunen, Statistics Finland 13 ol
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File|Save to menu /3

uuuuuuu

D:/PxEdit/doc/synt_005_201700.px
E:/Aikasarjat/Ammattikorkeakoulut/2003/AMKE203. px
D/ pxtest/erikieliset/Albanian.px
D:/pxtest/varoitukset/wrn_languagel.px

PX files
Text files
CSVY files

Close all but active
Close all

Exit

November 12th, 2019

"o o |+ XMLfiles
e e St « save the table in any of the three
s | coomamm different CoSSI/XML formats (xml)
| B » the Cals format may be fine-tuned with
| bt Settings|XML/Cals saving settings
Shift+ Ctrl+q XML/XDF file.
aia | e « HTML file
S - save the table in html format (htm)
Paraltoles « HTML table format is available, too
e » Sparse matrix
« save the table with KEYS settings
 Partial tables
« split the table into multiple files
along one variable
Veli-Matti Jantunen, Statistics Finland 14 "ll'
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File|Save to menu /4

uuuuuuu T

Saveto » :;t :I:E Ctrl+t ° ArC h Ive
D:/PxEdit/doc/synt_005_201700.px Ctrl+1 He- . .
E:mikasarjam:mamkorkeakojutfzmammmm.px Ctrl+2 Prlob-C3V e save and paCk the table to a ZIp file
D/ putest/erikieliset/Albanian.px Ctrl+3 eXlist-C5V
D:/pxtest/varoitukset/wrn_languagel.px Ctrl+4 Clipboard .
| = « eXplorer file
Text files > cel sheet ) )
SV files , B, « save the table as a input text file for
Close all but active Shift+ Ctrl+q imﬁ‘:[}:::e" the explorer appllcation
Close all Ctrl+q s Tie. .
Eat Meers | XMUKeysfile. « active only when the table has two
HTML file.. . :
— or three variables, and one of them is
Partial tables.. a rOW Va“able
Archive..
explorer file
Px:QLmacro.. o PXSQL macro

 save the table metadata and/or data
as a PxSQL macro

« the output is defined with the
Settings|PxSQL settings

 visible only if the database is defined

in the main ini file (sql_database=) 4,
November 12th, 2019 Veli-Matti Jantunen, Statistics Finland 15 - CL . !
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Excel...

* Reading from the Excel data sheet halts if the user Is
editing a spreadsheet cell

 the simple solution: just move away from the cell

« PxEdit tries to move the cell comments to appropriate
footnotes and vice versa

* excel notex setting in the main ini file controls the target
footnote keywords
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Create partial tables

BD (5] Population by country of birth and citizenship 1981-2003 X ° SeleCt the Variable a|ong Wh|Ch
Variable: courtry v swn the files will be created

Population total * [include
lceland

Other countries

Nordic courtries « Some values may be attached to

Denmark
Finland

Faroe |slands ar eaCh table
Greenland
Morway
Sweden

Other Eur. countries * File names are created from value

Austria

Belarus teXtS, COdeS Or bOth

Belgium
Bosnia-Herzegovina
Bulgaria

ot .  Files may populate their own
® codes [ I Create subdirectories Directory SUbdlreCtorleS

Otexts [ {Keep file name
(O both

esworldiceland/02 population! * The original file name may be kept
ema00301.px as the new name suffix

start creating the files Close

I
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Create a text file

E) (5] Population by country of birth and citizenship 1981-2003 b N DefaUIt SettlngS W|” Create a pure
S | structural monolingual text file
L] All value headers [ Append to file
Separate codes ] .

counlry country of bhcitizen__year « Header structure is freely adjustable
code ] | | . . .
- « all vs. hierarchical titles
nr::edinetm e texts, codes or both
endtext
— ] ¥ 0 « add leading or trailing texts

26 22 4

» fixed or automatic lengths

Field separator

Field length: 0 @ tabulator . .
Precetngtext: [~ enter precedit x | O gpace » The data part is also flexible
e o | June | - leading texts or zeros
[1Decimal comma other: :
[ Leading zeros  field length and decimal separator
Save. Close |  number of decimals
* The field separator may be practically
November 12th, 2019 Veli-Matti Jantunen, Statistics Finland anythlng (SenSItl)sle) "ll'
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Edit menu
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Edit menu /1

Edit h::tt::agtsa Window Language o ° Metad ata [Ctrl +m]
Import keywords. Ctrl+i « open the Metadata window
Import from eXist database..
Import from : .
 Import metadata [Ctrl+i]
Slr:::nd replace.. it:;i ¢ metadata (keywordS) may be
P vabie Shift Ctl+ imported from a separate px file or
Undo Ctil+2 from a pre-opened table
e o (the eXist database is being used in
r— Statistics Finland)

Data repor.  possible keywords will be shown

e i o in a separate import window
Split variable..
s ;  Defaults [Ctri+k]
Clone Ctrsd - available default values will be shown
Clone view Shift+ Crl+d In a separate window to be selected
ANSI <-> DOS and imported
ANS| <-> BIGS
November 12th, 2019 Veli-Matti Jantunen, Statistics Finland 20 ol
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Metadata editor

[6] Usnwlwl pbwlsnugwl pywpwliull — O

Vari

able:

puwn tnwphbGph

Keywords Meta patt View Select Sort  Edit  Add Anonymise

X

hy |

keyword

value

=
|; CHARSET ANSI
@ AXIS-VERSION 2010
& |CODEPAGE utf-8
8 | LANGUAGE
LANGUAGES en.hy
g CREATION-DATE 20120628 17:05
2 |pECIMALS 1
w | SHOWDECIMALS 1
% MATRIX DE3
S SUBJECT-CODE DE
SUBJECT-AREA Plwlsnugni
COPYRIGHT MO
DESCRIPTION
TITLE Uzinwluit plwlsnipqul puwpwilbiuyl
CONTENTS Uzinwiul plwlynipquwl puwpwlbwlyl
UNITS hwg.dwpn W tinlnund” pbinudsbh bl
CONTVARIABLE
LAST-UPDATED
CONTACT
SOURCE
LINK «a href="http:/farmstat. am/file/Qualitydec/a...
NOTE ! Cuwn Jwpnwhwdwph:#SnigwhgUbpp 6.
Hide Set.. Defaults Import..
‘ Close

14
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* Four sheets for editing table, variable,
value and cell specific keywords

« Formatted file meta data part

« Change and view the variable order
« Select parts of variables
« Sort the value texts

« Edit the value texts and codes
 Add new variables and values

* Anonymise data row-wise

- il
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Metadata importing

Fetch keywords

*

keyword

STUB, HEADIMG

- O
E:/StatFinfvrmisynt/statfin_synt... [1] El&vana syntyneet muuttujin...
fi ~ || fi w
Vuosi; Tiedot Aidin syntypera ja taustamaa; V...

VALUES("Vuosi)

1751 1752; 1753; 1754, 1755: 1.

2015; 2016; 2017

VALUES( Tiedot")

Kuolleisuusluku, promillea; Synt..

Elavana syntynest

AXIS-VERSION

2013

2010

CODERAGE iso-8859-15 Windows-1252
CREATION-DATE 20161005 09:00 20171121 09:00
MEXT-UPDATE 20200424 03:00 20191204 09:00
DECIMALS 2 0

MATRIX

synt_007_201800

synt_005_201700

DESCRIPTION

007 - Yleinen kuolleisuus- ja sy

005 -- Elavana syntyneet sukup...

TITLE

Yleinen kuolleisuus- ja syntywyy. .

Elavana syntyneet muuttujina Aj

CONTEMTS

Yleinen kuolleisuus- ja syntyvyy...

Elavana syntyneest

UNITS

Henkilaita, promillea

Lukumaara

LAST-UPDATED

20190426 09:00

20181204 09:00

CONTACT

Tilastokeskus#<A HREF=http:/it. ..

Tilastokeskus#<A HREF=http:/it...

DATABASE

O & O0Ogooiooooooeogid

StatFin

MOTE

<A HREF=http:/ftilastokeskus fi/..

=A HREF=http:/ftilastokeskus fi/. ..

[JCombine notes

Close

N

November 12th, 2019
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Separate selection window
for fetching metadata

Only the selected metadata will
be imported

* select with the left column check boxes

Only the metadata which seems to be
meaningful for import is selectable

Missing metadata is pre-selected

The contents of the keywords may
be explored (but not changed) in a
separate window by clicking the field

- il
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Default values

& peaut - 8 « Separate selection window

LAST-UPDATED="20191022 08:00"

CREATION-DATE="20191022 08:00" for defaUIt Values

L] | AXIS-VERSION=2013

o » Default values are stored in

DATABASE="StatFin" the perSOnaI Ini file

igﬂgz;ﬁ?rr|“;kkk * default values may be edited within
a separate window by pressing
the Defaults button in the
Metadata/Keywords window

OK Close P
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Edit menu /2

Edit Settings Window Language ° Gl‘aph [Ct”"‘g]

Metadata.. Ctrl+m

import keywords. Crli * opens a window for selecting

::z‘o’:::: S B , the desired data area and chart type
Defaults Ctrl+k

B e * Find and Replace [Ctrl+f]

e Shift Ctrl+f « opens a window for determining

Undo Crl+z the data value or data range

e o to look for in the table

e * itis also possible to change the found
Data report. values

Join tables.. Ctrl+j

Combine variables..

e * Find value [Shift+Ctrl+f]

Database >

Crnmtito > « opens a window for finding desired text
Clone Ctrsd In a long value list
Clone view Shift+Ctrl+d
ANSI| <-> DOS
ANS| <-> BIG5
November 12th, 2019 Veli-Matti Jantunen, Statistics Finland 24 "ll'
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Graphs: selection and chart window

Select chart data x
Rows: g = Chart..
Columns: 1=
Height {cm): 14~ []portrait
Fie chart ~ Close
Chart window — O *

Value of export (SITC, Rev3) 1997-2002

Lithuania: 68

Iran, Islamic Rep.of: 7

Portugal: 2
Namibia: 3
India: &
Germany: 10
Bahrain: 30

Bangladesh: 54

Greece: 50

November 12th, 2019
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e Selection window

there are five possible chart types,
which are available according to
the selection

e Chart window

double-clicking opens the settings
window for fine-tuning chart elements
(e.g. legend and title)

right-clicking opens the pop-up menu
for chart operations (e.g. saving to a
file or copying to clipboard)

- il
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Edit menu /3

Edit Settings Window Language
Metadagta.. o Ctrl+m ° Undo [Ctrl +Z]
import keywrds. Cel « undo the last edit (either cell change
RS R or clipboard copy) in the active table
mport from '
Defaults Ctrl+k
Graph.. Ctrl+g ® Copy [Ctrl +C]
Find and replace.. Ctrl+f
Find value.. Shift+ Ctrl+f open a separate COpy window
Undo Ctil+2 for copying data into the clipboard
Copy.. Ctrl+c
. Ctrlev * the current cell works as the anchor
Compare.. Ce”
Data report..
Join tables.. Ctrl+j
Combine variables.. o PaSte [Ctrl +V]
TR ) « copy data from the clipboard into
Carimit i , the table starting at the current cell
Clone Cri+d « data will be copied as far as possible
Clone view Shift+ Ctrl+d
ANSI <-> DOS
ANSI| <-> BIGS
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Edit menu /4

Edit Settings Window Language
Metadata.. o Ctrl+m ° CO m pare
Import keywords.. Crl+i « open the Compare window
Import from eXist database.. . . .
i ; « active if more than one table is open
Defaults Ctrl+k
Graph.. Ctrl+g
Find and replace.. Ctrl+f ¢ Data Report
(i shift Ctr+f « shows the data report for the data part
i S of the table
Copy.. Ctrl+c
Paste Ctrl+v
« Join tables [Ctrl+]
Data report.. . .
Jointa:les.. Ctrl+j ° Open the \JOI” WlndOW
e - active only if at least two tables with the
— : same number of variables are open
Convert to >
ey o « Combine variables
Clone view Shift+ Ctrl+d
6L b  Split variable
ANSI| <-> BIGS
November 12th, 2019 Veli-Matti Jantunen, Statistics Finland 27 "ll'
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Compare variables

EJ Compare texts or codes

Tables

ﬂ [ICodes ﬂ

[1] Value of export (SITC, Rev ~ | [2] Value of imports (SITC, Re ~

x

Variables 28 /108 / 161 287108/ 165
countries ~ | | country ~
Total "
Algeria Afghanistan

Antigua and Barbuda Albania

Argentina Algeria

Aruba Antigua and Barbuda

Austria Argentina

Australia Austria

Bahrain Australia

United States Bahamas

Bangladesh Bahrain

Barbados United States

Belgium Bangladesh

Belize Barbados

Bermuda Belgium

Bosnia and Herzegovina Bermuda

Botswana Bosnia and Herzegovina

Bolivia Bolivia

Brazil Brazil A
Check Close

1

* Visual tool for variable comparison

e case-insensitive

« green =the value is in the other list
* red = the value is not in the other list

« Code comparison is also possible

* Check button calculates the total
sum and compares the table data

cell by cell

November 12th, 2019
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gl Checksum results >

The table views are not equal.

OK

6 Table checksums: 3793617277 and 4533064895,

28
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Data report

E) Data Report X  Shows some information about the
data part
Cells: 1 248
gumhe_ri:31 {255%{}34,3%} « number of cells
Dot codes: 196 (15.7%) * number of figures (i.e. other than dot
2186 (15,7%) COdeS)
o 1 7 » used dot codes and their percentages
Mean: 30,49
- « Some other statistics
November 12th, 2019 Veli-Matti Jantunen, Statistics Finland 29 'lll'
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Join tables

EI Join tables

Original

[1] Value of export (SITC, Rev3) 1997-20 ~

O replace all metadata
(O replace missing metadata

(® do not replace metadata

Do not make a multilingual table

en | Combine

[2] Walue of imports (SITC, Rev 3) 1997~ ~

Match joining variables

Exact match
[ Bypass fill items

Pt

=

396 x 190 =75 240

O | year 6/ 6 |year 6/6 6
O |sImc 62 /62 | SITC 62/66| 66
® | countries 136 / 161 | country 136 /165 ) 190
Codes [ Do nat match
[ Use original values only [ Replace value metadata
Taotal -~
Algeria Algeria
Antigua and Barbuda Antigua and Barbuda
Argentina Argentina
Aruba
Austria Austria
Auctralia Avictralia =
[IClose the original tables [ Close the window
Multiple join [IMerge AA| Y| ¥
[

N
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* Any two tables with the same number
of variables may be joined

the variables will be joined according
to the current order (changeable)

the active table is selected to the left as
default if possible

* There are plenty of fine-tuning
options

* The result is always a new table

metadata copying

multiple table joining

value text arranging

value merging after the join operation
fill item bypassing

20 il
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Multiple table joining

) Join multiple tables * ®

1] Viennin kehitys koko maassa by Vuosi, Kuukausi, Maakunta, Toimialat and In._.

[
[

2] Viennin kehitys Uudellamaalla by Vuosi, Kuukausi, Maakunta, Toimialat and In...

3] Viennin kehitys Itd-Uudellamaalla by Vuosi, Kuukausi, Maakunta, Toimialat an...

[
[

]
]
]
4] Viennin kehitys Varsinais-Suomessa by Vuosi, Kuukausi, Maakunta, Toimialat...
]
]

5] Viennin kehitys Satakunnassa by Vuosi, Kuukausi, Maakunta, Toimialat and |

6] Viennin kehitys Kanta-Hameessa by Vuosi, Kuukausi, Maakunta, Toimialat an...

7] Viennin kehitys Pirkanmaalla by Vuosi, Kuukausi, Maakunta, Toimialat and In...
a8
g9

Wiennin kehitys Paijat-Hameessa by Vuosi, Kuukausi, Maakunta, Toimialat an...

= ==

WViennin kehitys Kymenlaaksossa by Vuosi, Kuukausi, Maakunta, Toimialat an...

10] Viennin kehitys Etela-Karjalassa by Vuosi, Kuukausi, Maakunta, Toimialat an...

11] Viennin kehitys Etela-Savossa by Vuosi, Kuukausi, Maakunta, Toimialat and _..

13] Wiennin kehitys Pohjois-Karjalassa by Vuosi, Kuukausi, Maakunta, Toimialat ...

14] Wiennin kehitys Keski-Suomessa by Vuosi, Kuukausi, Maakunta, Toimialat a...

18] Wiennin kehitys Etelad-Pohjanmaalla by Vuosi, Kuukausi, Maakunta, Toimialat...

16] Viennin kehitys Pohjanmaalla by Vuosi, Kuukausi, Maakunta, Toimialat and |_.

17] Viennin kehitys Keski-Pohjanmaalla by Vuosi, Kuukausi, Maakunta, Toimiala...

18] Wiennin kehitys Pohjois-Pohjanmaalla by Vuosi, Kuukausi, Maakunta, Toimia...

[
[
[
[
[
[
[
[12] Viennin kehitys Pohjois-Savossa by Vuosi, Kuukausi, Maakunta, Toimialat a...
[
[
[
[
[
[
[

Wiennin kehitys Kainuussa by Vuosi, Kuukausi, Maakunta, Toimialat and Ind...

KA R A E AR EE R R AR E A E AR E]

]
19]
[20] Wiennin kehitys Lapissa by Vuosi, Kuukausi, Maakunta, Toimialat and Indeksit

[ Match joining variables MMx16=234 A A| v ¥

combine the tables

Join Close L,
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If there are more than two tables
open that have the same number
of variables, the Multiple join check
box will be active

The Join button will open a
separate multiple table joining
window If selected

« join tables can be selected with
the check boxes

« the joining order may be changed
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Variable combining

B9 Combine variabies - Box * The left list shows the table variables
gi?'n[nmndit > Leuirth ] ] ] ]
m{}m < * The right list contains the variables to
be combined
« the variables may be copied (and
removed) by double-clicking the variable
Serle Iox names or using the angle buttons
[ ] Time series
——— Close * The Time series selection will make

the corresponding TIMEVAL
expression, if possible

* The result is always a new table with
the combined variable

» the corresponding keywords will be
changed or removed

2 il
Statistics Finland
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Variable spllttlng

9 Spit variable - O * The drop-down menu shows the table
Month v variables
(O length
©separator  [leave E * The selected variable may be split in
[ s o two based either on the length of the
- (coded) value text or on the special
separator

* the value texts and codes will be split
according to the chosen method

 all the new values and codes must be
unique

 The result will be a new table with a
new variable

* the new variable name will just have a

numerical suffix (e.g. Month-2)

November 12th, 2019 Veli-Matti Jantunen, Statistics Finland 33 Statistics Finland "ll'



Edit|Database menu /1

Database ) Freshness > * Freshness sub-menu

;m Cm} ::":"M * set how old files will be read in
Clone vicn it Cortad o the database functions

ANS| <-> DOS Check metadata..

ANSI <-> BIGS Standardise.. ° RepOrt

Show log..

« create database report

e Show report

 if the report has been run during the
session and the report window has
been closed, this selection reopens it

 Check

« read all px files in the database and
make an error log of each detected
problem
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Database report /1

&) Report retir -8 * The left list shows the report contents
g E : Run - special controls (0)

2|0 Rerun « keywords (levels 1..4)

|0 Open

g : oo * The report consists of selected

=0 — controls and possible filters

=1 « double clicking any keyword or filter

Olo controls (with dark blue background)

Olo opens a different input window in which
g 0 the filter values may be added

0 . .

Ol « filtering texts are not type checked (e.g.
O/o . language codes) and they are not case
0o DE'm;ce”s sensitive

= 2 - the keyword filters affect only the

1lo | [A][A] [¥] [+ keyword output, thus making empty cells

Close In the report
November 12th, 2019 Veli-Matti Jantunen, Statistics Finland 35 'IH'
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Database report /2

&) Report reation - 0 X  The Rerun button is active, If the
0 Run report has been run previously
Rerun * the run location is remembered across
open sessions, but special settings are not
Save .
- * The defined report may be saved as a

csv file for further use

* may be used as a control file in PxJob
reporting

* The angle buttons may be used for
changing the default order

[JHide

L] Empty cells
23

wil | & ALY

&

gigigioggoauogE & OEE OO

Close
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Edit|Database menu /2

Datebase | Frenes :  Check metadata
Convert to » . ]
Clone | — * like Check, but the data part is not
o Shifts Ctrle o o checked (making the process a lot
ARSI <-= DOS Check“metadata.. qUICker)
AMSI =-> BIGS Standardize..

S - Standardise

* |ike Check, but the files will be written
back to the database

* the Settings|Keep file date and
Settings|Freshness settings may be
usable

« Show log

* this selection opens the latest Check,
Standardise or Convert log
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Database report log

* The report may be copied to Excel or saved as a csv file
« aselected file can also be opened in PxEdit

» the columns may be sorted by double-clicking the headers

£l Checking log - O X
pathname filesize fileupdate tablesize languagecode A
E:Mtesti-pxlasulasasistatin_asas_pxt_001 px 1337565 [2017-06-06 14:25 | 312 x (8x5x32x1) = 399360 fi Alue, Asuntokunnz
E-‘testi-pxlasulasasistatfin_asas_pxt 001.px 1337565 |[2017-06-06 14:25 | 312 x (8x5x32x1) = 399360 sV Omrade, Bostadsh
E:Mtesti-pxlasulasasistatfin_asas_pxt 001 px 1337565 [2017-06-06 14:25 | 312 x (8x5x32x1) = 399360 en Region, Size of ho
E:\testi-pxlasulasas\statfin_asas_pxt 002 px 7495812 [2017-06-06 14:25 | (312x%8x5x9) x (12x2) = 2695680 |fi Alue, Asuntokunnz
E:Mesti-pxlasulasasistatfin_asas_pxt 002 px 7495812 [ 2017-06-06 14:25 | (312x8x5x9) x (12x2) = 2695680 | sv Omrade, Bostadsh
E:\testi-px\asul\asasstatfin_asas_pxt_002.px 7495812 | 2017-06-06 14:25 | (312x8x5x9) x (12x2) = 2695680 | en Region, Size of ho
E-testi-pxlasulasasistatin_asas_pxt 003 px 269456 | 2017-06-06 14:25 | 312 x (27x6) = 50544 fi Alue, Vuosi, Yksik
E:Mesti-pxlasulasas\statfin_asas_pxt_003.px 269456 | 2017-06-06 14:25 | 312 x (27x6) = 50544 sV Omrade, Ar, Enhet
E-testi-pxiasulasasistatfin_asas_pxt 003 px 269456 | 2017-06-06 14:25 | 312 x (27x6) = 50544 en Region, Year, Unit
E:Mesti-pxlasulasas\statiin_asas_pxt_004 px 6370114 [ 2017-06-06 14:25 | (312x12) x (9x5x8x3x1) = 2246400 | fi Alue, Vuosi, Asunt
E-testi-pxiasulasasistatfin_asas_pxt 004 px 6370114 [ 2017-06-06 14:25 | (312x12) x (5x5x8x3x1) = 2246400 | sv Omrade, Ar, Bosta
E:Mesti-pxlasulasasistatin_asas_pxt_004 px 6370114 [ 2017-06-06 14:25 | (312x12) x (5x5x8x3x1) = 2246400 | en Region, Year, Size
E-‘testi-pxlasulasasistatfin_asas_pxt 005 px 99481 2017-10-11 08:21 | (312x7Tx5) x (2x12) = 262080 fi Alue, Hallintaperus
E:Mtesti-pxlasulasasistatfin_asas_pxt 005 px 994811 2017-10-11 08:21 | (312xTx5) x (2x12) = 262080 sV Omrade, Upplatels
E:\testi-pxlasulasas\statfin_asas_pxt 005 px 994811 2017-10-11 08:21 | (312xT=5) x (2x12) = 262080 en Area, Tenure statu
E-Mtesti-pxlasulasasistatfin_asas_pxt 006 px 180398 [ 2017-06-06 14:25 | 312 x (Ixbx11x1) = 51480 fi Alue, Asunnon kay
E:\testi-px\asul\asasstatfin_asas_pxt_006.px 180398 | 2017-06-06 14:25 | 312 x (3x5x11x1) = 51480 sV Omrade, Bostader v
< >
Open Save Excel Close

[
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Edit|Convert to menu

Convert to »s « Database files may be converted to
Clone Gk different file formats
Fonevien e PSQL. - there are many settings in the Settings
ANSe=> DO —— menu, which should be checked first
AMNS| <-> BIGS B
* The conversion log will be shown in a
separate window
« Show log
 this selection opens the latest Convert,
Check or Standardise log
November 12th, 2019 Veli-Matti Jantunen, Statistics Finland 39 "ll'

Statistics Finland



Edit menu /5

Edit Settings Window Language

Metadata..

Import keywords..

Import from eXist database..
Import from

Defaults

Graph..
Find and replace..

Find value..

Undo

Copy..
Paste

Compare..

Data report..

Join tables..
Combine variables..

Split variable..

Database

Convert to

Clone

Clone view

ANSI| <-> DOS
ANS| <-> BIGS

Ctrl+m

Ctrl+i

Ctrl+k

Ctrl+g
Ctrl+f
Shift+ Ctrl+f

Ctrl+z
Ctrl+c
Ctrl+v

Ctrl+j

Ctrl+d
Shift+Ctrl+d

>
>

November 12th, 2019
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 Clone [Ctrl+d]
» duplicate the table (with editing history)

* Clone view [Shift+Ctrl+d]

« copy the table with the current settings,
l.e. tabulation, selections, ordering and
value texts (without editing history)

* ANSI <->DOS

 if the input file is converted incorrectly
as DOS or ANSI coded, the coding can
be reversed with this function

* ANSI <-> BIGS5

 enables the Taiwanese character
conversions

« shown only if the big5 conversion
option is set in the ini file

20 il
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Settings menu
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Settings menu /1

Settings  Window Language

User level

Window titles

Variable headers

Colour codes
Column widths
Anchor input
Dot code sum

Fill itern

File reading

File saving

Structural table
Excel

XML/ Cals
HTML
PxSOIL

Language

Character conversion

Font

November 12th, 2019 Veli-Matti Jantunen, Statistics Finland

e User level sub-menu
 Window Titles sub-menu
 Variable Headers sub-menu

 Colour codes
show the range colouring in tables

« Column widths
resize columns automatically

« Anchor input
keep the field edit windows in place

Dot code sum

select between PxEdit and px summing
methods
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Settings|User level menu

SE“i”f; ;m.l e . * The settings affect the user interface
W £ B —— * the user may change to the preferred
VEI:E:;‘:::EZSEFS *> * ET{FI-EI"t HsEr Settlng anytlme

* Base user

* minimum set of menu choices,
action controls and functionality

* no data editing allowed
« suitable for beginners

 Advanced user
« most used functions available

* Expert user
e all functions available

 used in this documentation
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Settings|Window titles menu

Window titles > '@ | PXdefault e PX default
Variable headers >|  Tabledescnption « Window title from the TITLE keyword
»  Colour codes File name
 Table description
 Window title from the DESCRIPTION
keyword
* File name
* Full path name
November 12th, 2019 Veli-Matti Jantunen, Statistics Finland 44 "ll'
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Settings|Variable headers menu

VEITTLILW LILIES

Yariable headers

» Colour codes
"  Column widths

Anchor input

Mnat rode coem

November 12th, 2019

*

Text headers
Code headers

Both

All headers

Veli-Matti Jantunen, Statistics Finland

» Text, Code or Both headers
« show the value texts in titles (blue), or
« show the value codes in titles (red), or
* show both in titles (purple)

* All headers
o |f set, show all values for all variables
e |f not set, show the hierarchical structure

45 il
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Cell colouring

B 11 colours - B X e Statistics Finland’s colour palette
File Edit Window Language ] L .
arvo_t arvo_2 arvo_3 A » five green shades for positive figures
e e - five red shades for negative figures
wosi_3  blue shades for dot codes
wuosi_4 . .
s £ 10,000 10 000 zeros and nils are grey
wuosi_b 20.000 . -20.000
e 1100 - 2348 « Can be changed in the main ini file
- e ' — d ([Colours] section)
8 rows ¥ 3 columns = 24 figures A
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Settings menu /2

Settings Window Language

User level >
Window titles >
Variable headers >

" Colour codes
= Column widths
Anchor input

Dot code sum

Fill itern >
File reading »
File saving »
Structural table >
Excel »
XML/ Cals ¥
HTRL ¥
PxSCL ¥
Language »
Character conversion »
Font ¥

November 12th, 2019
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 Sub-menus for

which value will be used for the Fill Item
file reading settings

px file saving settings
structural table saving settings
Excel saving settings
XML/Cals settings

HTML settings

PxSQL settings

Interface language

character conversion settings
font selections
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Settings|File reading menu

Check for Unicode

« check for the possible Unicode coding

Mandatory footnotes
Sparse rmatrix fill .

XML/Cals > » show the NOTEX keywords when opening

the table
Replace dash sub-menu

« select the value used to replace the dash

character when reading structural tables

Decimal separator sub-menu

« select the decimal separator for file reading
(usually does not need to be set)

Sparse matrix fill

« are the sparse matrices filled
with Fill items or zeros

File reading » Check for Unicode

File saving ¥ Mandatory footnotes
Structural table » Replace dash »
Excel y Decimal separator >
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Settings|File saving menu

e I\_IJHIIIH

Save in Unicode

File saving > Save in Unicode
Structural table y | Lowercasefilenames « will the output files be in Unicode
Excel 3 Keep timestamp .
Set timestamp * Lowercase filenames

Ak " Ignore base language * write output file names in lowercase
HTRAL > .

~  Check sparsity
PxSCL b °

, Keep timestamp
« will the file timestamp be updated when saving

Set timestamp
« will the file timestamp be set according to
LAST-UPDATED
Ignore base language
« do not copy texts from base language

Check sparsity

« will the table be checked before sparse matrix
saving to see if the sparse format is meaningful

« uncheck this before saving a big matrix

November 12th, 2019 Veli-Matti Jantunen, Statistics Finland 49 Statistics Finland "ll'



Settings|Structural table menu

Structural table » Decimal precision
Excel * % Decimal comma
XML/ Cals - Multilingual
HTML 3 Language code
PxSCL * I »  Codes
Language - loin codes
Character conversion . Keyword block

Footnotes

*

Font Hierarchy levels

« Decimal precision « Codes
« use the shown decimals when saving « add codes to the table
« Comma separator  Join codes
¢ use comma as decimal separator « combine codes with the value texts
« Multilingual « Keyword block
« make multilingual tables « add metadata description under the table
« Language code * Footnotes
« add language code to the header line « add footnotes below the table
* Hierarchy levels
« add hierarchy levels to the table I
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Settings|Excel and Language menus

Ll D L L I

Excel B celinotes  Cellnotes
XML/ Cals > Column widths | « copy cell notes as Excel comments
e Column widths
« set Excel column widths automatically
| .

— 1 e « Language menu shows all available
Character conversion ¥ Dansk |nterface Ianguages
Font >|  uem - language files are in the Languages folder

Pyccknia

Slovenski jezik

Svenska

YepaiHceka
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Settings|XML/Cals menu

XML/ Cals > Decimal precision g DeC|ma| preC|S|0n
Tt g e seperator . use the shown decimals when saving to
PxSOL * »  Column decimals Cals
Language > | ® Nothousand separator
Character conversion Space
. 2 e - Comma separator
Font . Mon-breaking space
Comma (or period) * use comma as decimal separator
Cluote
e Column decimals
« set column decimals before saving
(overrides the decimal precision setting)
« Thousand separator settings
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Settings|HTML menu

HTML > [ Tablestyle « Table style
PeaL > Pofissiyle « mimics the way the table is shown in
Language » Adjusted px style PxEdit window
Character conversion » @ Coloured cells
Font S * PcAXis style
Mo colours . )
* indents the row variables the same way as
PcAxis does
« Adjusted PcAxis style
« puts the last variable as column variable
and indents the table like PcAxis
 Cell colouring settings
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Settings|PxSQL and Font menus

Px50L

Language

Character conversion

Font

Font

Save the meta part

Save the data part

Save both parts

Save the data part in C5V

Drop and create commands

o

Text font..

November 12th, 2019

Systemn font..

Default font

Veli-Matti Jantunen, Statistics Finland

» Select the needed PxSQL output type

« System font affects mainly the
Interface elements

 Text font is being used for input fields,
spreadsheets and lists

* The font size may be changed with
Ctrl+MouseWheel or
Ctrl+UpArrow/DownArrow

- il
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Settings|Character conversion menu

uuuuuuuuu - 1

Character conversion b Wi”ﬁ*”mmdfﬂﬂ ¢ WII’]ANS| COdlng
1ISO-8859 coding

« which character coding to use when
saving px files

Font ¥

Ignore coding

Systemn language coding
DS coding

Ignore coding

* bypass the CODEPAGE setting when
reading px files

System language coding

« whether the text encoding will be based
upon the system or table language

DOS coding

« open the tables without CHARSET setting
as DOS or WinANSI coded
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Other menus
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Window menu

wmd:: e Shift+Ctrl+1 F it [S h i ft + Ct r I + I ]

Arrange Ctrl+l ., . . .
[1] BEFEEFRARELR-F by BIE, HEA T, EFE10UE, IE W and 1538 ¢ pOSItlon the Current table In the main

[2] Area, population and population density by province by Cities, provincies, Year and tems WI n d OW
[3] UQD3010 Censumption of oil in tonnes by consurmer groups (1992-2018)

[4] lzdadeni odobrenija za grdenje po regioni

[3] 3araneHoOCEITHI HABYANEHI 33Knagn - 3MicT, Teputopia i Pik

[6] Population by Regions, Municipalities and Vear Arran g € [Ct r I + I ]

[7] POPULATION (DE JURE) by years and indicators ° 1
~  [8] Expenditure of general government sector by function by secter, function and time |Ocate the_ table WIndOWS
In the main window

« Table names may be used to change
the active table
 Note: Ctrl+Tab shortcut can be used as
well
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Language menu

Language
en englanti
Vi Vietnamese
fo Faroese
mk Macedonian
uk Ukrainian
ka Georgian
hy Armenian
da Danish
kl Kalaallisut

November 12th, 2019
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* The language shown in every open
table may be changed with the
Language menu

helps operating with several

multilingual tables
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Help menu

e | - Help file [F1]
Help file.. F1
pch el  PxJob help
Ile format
Message file. » open the PxEdit or PxJob help file
» PX file format
P homepage.. . L. .
— « open the px-file format description file
Feedback. * Message file
Ahout Pt e - ifthereis amessage file settingin the
main settings file, this selection becomes
available
 Forum
« open the general discussion board in the
browser
« Feedback
« open Statistics Finland’s feedback site
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Help files

PuxEdit Help *

PxEdit 4.0

0. General

FxEdit is an editing tool for px-files developed by Statistics Finland's Database

team. Its basic principle is to provide maintainers of Px\Win and PxWeb-based
services with an easy-to-use expert tool that supports all the px features found
essential at Statistics Finland.

PxEdit can be used to directly edit metadata of px-files.
It can also be used via the command line without the graphic user interface (batch
jobs).

PxEdit checks the px-file structure when the file is opened, reports possible syntax
errors, is able to repair many of the most frequent ones; and when saving the
table the output format is always standardised: the keywords are saved in fixed
order, the keyword and data syntax and format are valid.

FxEdit can be used to convert Excel and text files into px-files and correspondingly
to export px-files into Excel and as text files.

[ Precise search

Search

Search text: =

Print.. Close

W

£
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« A separate Rich Text (rtf) file
« simple text search

» clipboard support
* no formatting, though
e printable

* Pressing F1 in the application
should open the related section

* New features and changes are marked
In blue

* The PxJob help file works the same way
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PX-file format

PxEdit Help X

PX-file format specification
AXIS-VERSION 2013

1 Reader's guide
1.1 What this instruction covers

This manual describes how a PX file is constructed.

The manual is intended for people who want to get a introduction of how to use and to extend the
Core part of the PX SDK_ The readers are not required have any type of PX experience to
understand the content but it helps.

1.2 How this document is organized

The document is divided into two parts. The first part defines how the PX file structure works.
The second part defines all keywords used in the PX File Format.

13 Related documents v

Search text: ® ‘ | Search | [1Precise search

Print.. Close

1

November 12th, 2019
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A separate rtf file

Edited from documentation by SCB
(Statistics Sweden)

Simple text search

Clipboard and printing supported
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PxEdit homepage
B o comeroninaine . < |

¢ ‘@' 0] www.stat.fiftup/tilastotietokannat/px-tuoteperhe_en.htmil E

. @

Tilastokeskus Statistikcentralen Index | Site map

I|||
Statistics Finland'’

Search the site

HOME STATISTICS METADATA DATA COLLECTIONS PRODUCTS AND SERVICES NEWS STATISTICS FINLAND

Home > Products and services » Statistical databases » Px suite (former PecAxis suite)
PRODUCTS AND SERVICES
Px suite (former PcAxis suite)

The Px suite is a collection of programs developed for the distribution and processing of
statistical tables. They offer diverse possibilities to distribute and edit even large statistical
tables, and to change structures, combine tables, make calculations and convert into other file
formats.

Statistical databases

Px suite (former Pofxis suite)

PxWeb

PxWeb is a free web-based table distribution system for statistics producers. All Mordic statistical
institutes use the PxWeb system. Maore information about the distribution system can be found on
the pages of Statistics Sweden (SCB).

All of Statistics Finland's statistical databases have been created with the PxWeb distribution
solution. In addition to Statistics Finland, some other producers of Official Statistics of Finland
also maintain FPx\Web databases.

PxWin

M B emm el mm ddle e ol d Mhadesi; mmm mmmeme Ted A fm mem mem ol om mm mem e i mmdimom £ B

o e e ol

Our web senvice uses cookies to improve the user experience. By using the senvice, you consent to the use of cookies.
Read more about cookies

mode@e =

Feedback | Contactinformation

Suomeksi P3a svenska
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PX homepage
- 8 Stotistical programs for Pfles % N

G @ @ @ https://www.sch.se/px-en B - % I 0 @ &

sﬂﬂ Pasvenska A-Z Contactus

Home  Finding statistics  Services  Documentation  Data collection  Aboutus

Home / Services / Statistical programs for Px-files

Data collection and o) Listen
surveys

: - . °
e Statistical see also
:ﬁz I:iazt;c:;:;sindustry pr 0 gr ams f Or PX- Discuss questions

about the PX-
Guidance for researchers

and universities ﬁles programs in our

Google group

+

Statistics Sweden's +
Business Register

Px is a standard format for statistical files PX Google group

Statis‘tical DrOgI‘amstlr — timemel s o larmeas miimebeosr oF sadbostiostismsl o
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The discussion forum (GoogleGroup)

B (99+) pcaxis - Google Gro... X | +

€ | D & nhttpsy//groups.googlecom/forum/?hizen-GB E= @ & | Q Haku 4+ f B 4 - © u > B - @ * @ =
Go gle - “ # 0 °
Groups C Mark all as read Filters « -2 o 00
My groups < PCaxis Shared privately
Home 31 of 139 topics (99+ unread) ¥ Members - About (=)
Lal
Starred This group is for discussions and information about the PC-Axis family
~ Favourites PX-Win 1.2 (6)
By Asa Arthén, SCB - 6 posts - 41 views X 7 Feb
Click on a group's star
icon to add it to your PX Win 1.2 Tools menu not working (4)
favourites By Goran K - 4 posts - 3 views 12 Apr
PC Axis International Meetings (1)
+ Recently viewed By Danniel Segun - 1 post - 4 views 6 Apr
» Recently posted to L.
Charts not showing in second language (7)
By Meil Cory, SLU - 7 posts - 17 views 23 Mar
Privacy - Terms of Service
[PX-WIN 1.2] connection with a Oracle Database (2)
By elisav...@gmail.com - 2 posts - 17 views 17 Feb
Select classification in px web (step2 choose variable) (1)
By Uldis Ainars - 1 post - 14 views 31 Jan
Happy New Year :-) (3)
By Eydun Mielsen, Statistics Faroe Islands - 3 posts - 26 views 5Jan
Multi language synonyms - difference between PX-Edit and PX-Web (13)
By Eydun Mielsen, Statistics Faroe Islands - 13 posts - 31 views 02122016
Documentation on agg an vx files (2)
By Torbjarn Lindquist (konj.se) - 2 posts - 17 views 29/11/201
"'n" Item with the same key error (21) v
November 12th, 2019 Veli-Matti Jantunen, Statistics Finland
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The feedback site for Statistics Finland

# Tilastokeskus - Yhteystiet.. X 4

€ | (D ftilastokeskus.fi/sivusto/palautelomake_en.html

Statistics Finland

HOME STATISTICS METADATA

Home > Feedback —=

e Q|

Tilastokeskus

Q, Haku
Statistikcentralen Index | Site map

Search the site

S FINLAND

Feedback

You can use this form to give feedback to Statistics Finland, .. suggestions forimprovement,
criticism or thanks.

Mature of feedback* O Question O Suggestion O Thanks O Criticism

Actual feedback *

Mame: |

Company/Organisation: I

E-mail: |

Telephone: |

Areplyis:

*Required information

O Required by e-mail [l Required by telephone

MB If a reply is required, be sure to leave your contact information

Feedback

+ ATNE 4 C-0 uwo Bp- M @

Contact information

Suomeksi

P& svenska

O X

November 12th, 2019

Veli-Matti Jantunen, Statistics Finland
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About PxEdit [Ctrl+F1]

Information

PxEdit 2019.4.0.1606 [tustal 7. kesdkuu 2016]

Copyright:

Statistics Finland/TR/PeTi

PxEdit Team:

WVeli-Matti Jantunen,
Hans Baumgartner

Application developed with:

Dwyalog APL 17.0.37073.0 [56f634a6]
www._dyalog.com
www _tryapl.org

Charting: RainFro 5.4e

Adrian Smith
adrian@apl385.com

OK

X

November 12th, 2019

Veli-Matti Jantunen, Statistics Finland

« Complete version number
« Creation date

 Credits, culprits and copyright

* The DyalogAPL version and [BuildID]
* The RainPro Graphics engine version

« Alt+F1 shortcut shows a slightly more
detailed information window
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